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If you have already downloaded Katabounga, you should find the 
“Katabounga folder” on your desktop. This folder contains :

1  Katabounga

2  Katabounga Modules

3  Quickstart Media

4  Read Me

Then double-click the “Read Me” file for specific system requirements 
instructions.

1  Locate and double-click on the “Katabounga” icon to 
start the program.

2   Pull down the File menu and select New Scenario. 
The scenario setup dialog box will appear.

3  Click OK. The working environment will appear.

Katabounga, an alternative solution for multimedia authoring combines efficiently ease of use and rich functionality. 
Tedious programming is no longer necessary. Object based, Katabounga offers you access to its essential power 
without having to write a line of code.



In the Scenario window, double click on Screen 0 to make the first screen appear. 

1) The Scenario window
2) The Screen window
3) The Media palette
4) The Tool palette
5) The Object attributes palette
6) The Commands palette
7) Katabounga assistant/ Trash

When working with Katabounga, three modes are available :

1 The Edit mode. This mode allows you to work on objects and media to create a multimedia presentation.

2 The Play mode. The play mode allows you to test your work while developing your project.

3 The Runtime mode. The last step in a project is to create a runtime, a stand alone application free of 
royalties that will allow other people to discover and enjoy your project.
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After starting Katabounga, the question is how do you assemble your project. We will look at how we can :

  
• Add media to the project,
• Create and rename screens, 
• Place the media on the screen,
• Navigate through your project, 
• Change the background color.

Media are pictures, texts, sounds, movies, VR files, sprites (flipbook animations) and buttons. Katabounga allows you to 
assemble these elements but also to create and edit some of them such as sprites and buttons.

Creating the screens involves the Scenario palette.
Click on the “create screen” button to create new screens. If you need to delete a screen, select it and drag it to the 
Katabounga assistant or the desktop trash.

Click on the “create screen” button 
and create three new screens.

1  Click the “+” button in the Media palette.

2   Locate the “Media” folder inside the 
folder “Katabounga” located on the 
desktop.

3  Click “Add”. The media items will appear
in the Media palette.



Screens can be renamed by selecting the screen name in the Scenario window and typing the new name.

Katabounga is an object oriented tool that allows the user to place media easily by dragging them onto the Screen 
window. As soon as a media item is placed on a screen it becomes an “object”. This object can appear multiple times 
on the same screen or on multiple screens.

1  Click on “Screen-0” and rename it 
“Summary”.

2  Click on “Screen-1” and rename it 
“Film”.

3  Click on “Screen-2” and rename it 
“Sprites”.

4  Click on “Screen-3” and rename it 

“VR”.

In the Media palette, select and drag 
“-SUMMARY” onto the screen 
window.



There are two ways to move from screen to screen. In the Screen window, you can click on the arrows that will take 
you to the previous or next screen. You can also go to another screen by double-clicking on a screen in the 
Scenario window.

For each screen :

1  Go to the next screen.

2  Place the relevant media item in the screen.

Changing the background color is easy. 
Go to the Screen window and select a 
color in the color palette.

Change the color of all 
backgrounds to white. Keep 
the “Sprites” screen 
background black.



1  Double click on the “Summary” screen 
in the Scenario window.

2  Go to the Media palette and select and 
drag “Arrow_left” onto the bottom left 
corner of “Summary” screen. 

3  In the Command palette, select the 
“Go towards screen” command 

and drag it onto “Arrow_left”.

4  In the objects, double-click on the 
command icon.

  
The parameter dialog box will appear.

5  In the Command zone, hold the mouse 
down on the “Go to next screen” icon. A 
pop-up menu will appear. Select “Go to 
next screen”.

6  Follow the same procedure for 
“Arrow_right”.

Once assigned to objects, screens or sequences, commands will allow you to determine the scenario’s functions 
and create interactive presentations that will astound you.

Double-click Double-click



1  Go to the Scenario Menu and select Run. Or using the keyboard,
press Command-R.

2  Click the right arrow to go to the “Film” Screen. You may have noticed that the arrows have disappeared. 
You now have no way out of this screen.

3  Hit the Escape key to get back to the Edit mode.

4  You will need to turn the navigation arrows into Global Objects to have them showing up in all screens.

5  Holding down the Shift key, select the 
two arrows in the screen.

6  In the Object palette, click the Global
Object checkbox on.

7  Run and test your work. You are now able to go from screen to screen using both arrows.

8 For safety reasons, it may be the right time to save your project. Go to the File menu , select Save. 

The easiest way to check your work is to run your project.

  - R

With objects already placed on the screen and commands assigned to these objects, you may want to see how it 
is organized.

1  Go to the Scenario window and click the arrow next 
to “Summary”.

2  If “Right_Arrow” and “Left_Arrow” are not Global objects, 
they are only displayed in the “Summary” screen (Fig.1). 
Otherwise, they are assigned to a Sequence (Fig.2).

1

2



1  Go to the Media palette.

2  Hold the mouse button down on the Help arrow 
and select “New Button”. 

3 Save the new button as “Button_Camera” in the 
“Camera” folder.

In this section you will create buttons. Buttons are made of a series of images that change according to the button’s 
state.

4  The button import dialog box will appear. Click on the “+” button to 
add the components of your button.

5  Select the “Camera” folder and click on the 
“Add all displayed files...” button to bring all the 
images in the folder. Another way to bring
these components is to drag the image files
from the desktop into the button parameter 
dialog box.

6 Your button (“Button_Camera”) is now 
ready.            ready. The same procedure was used to

create the “Button_Sprites” and 
“Button_VR” buttons.

7  Go to the Media palette and drag  
“Button_Camera” onto the screen. 

8 To enable this button to bring you to 
the “Film” screen, go to the scenario 
window and drag the “Film” icon onto 
the “Button_Camera”. Using the 
procedure we just described, enable 
“Button_Sprites” and “Button_VR”.

9  Test your work and hit the Escape 
key to get back to the Edit mode.



1  Double-click on the “Film” screen icon in the 
Scenario window to make it your working screen.

2  Go to the Media palette and drag the QuickTime 
movie “Space Shuttle” onto the “Film” screen.

3  In the Command palette, select and drag the     
“Start Object” command onto the QuickTime 
movie.

4  On your keyboard, hold the command key and hit 
the “G” key to test your project from this specific 
screen.

5 Click on the movie to start it. Hit the Escape key 
to get back to the Edit mode.

Starting a QuickTime movie

After going through all the basics of interactivity in Katabounga, we will look at how we can take advantage of 
QuickTime movies.  You will learn how to start a QuickTime movie, how to show and hide objects and how to 
synchronize events with a movie.

  - G

1  Double-click the Start Object command in the QuickTime movie.

2  The parameters dialog box will show up.

3  Click the “Synchronization Messages” box on. This option allows 
the QuickTime movie to send messages to all objects in the 
screen. We will use this capability later on to synchronize events 
with the movie.

1  Go to the Tool palette and select the “Edit 
Text” tool.

2  In one motion, click and drag in the screen 
to create the text area.

3 Type “Bye bye !”.

Before working on synchronizing events, we will create an object ( Bye  bye !) that we will bring onto the screen 
when the shuttle is leaving towards the sun.



4  Pull down the Format menu and adjust the 
Font (Times), Size (36), Alignment (center)  
and Anti-aliasing to smooth the edges.

5  Go to the Object palette and click the 
“Hidden” check box on to hide the object 
when the screen starts. 

6 In the Object palette, you may also turn 
the color background of the object to yellow.

1  In the Command palette, select and drag the  
“Display / Set Object” command onto 
the “Bye bye !”  object.

 

2  Double-click on the Display / Set Object 
command in the “Bye bye !” object. The 
parameters dialog box will show up.
 
3 Hold the mouse button down over the “Mouse  
Up” icon. A pop-up menu will appear. Select 
“Message”.

4  Another field will appear. Type “SpaceShuttle  
25” as shown on the screen shot below.

It is now time to work on having, like in a cartoon, the “Bye bye !” object showing up when the space shuttle is 
leaving towards the sun.

As we enabled the QuickTime 
movie “SpaceShuttle”  to send 
synchronization messages, each 
frame of the movie is sending a 
message “name–of–the–movie 
frame_number”. In this case, the 
object “Bye bye !” will appear 
when the frame number 25 of the 
movie “SpaceShuttle” will be 
shown.

5  Run your presentation from this 
screen.

  - G
Click on the movie to start  it and 
see the “Bye bye !” showing up 
when the space shuttle will leave 
towards the sun. Hit the Escape 
key to get back to the Edit mode.



1  Double-click on the “Sprites” screen icon 
in the Scenario window to make it your 
working screen.

2  Go to the Media palette. Hold the mouse 
button down on the Help arrow and select  
“New Sprite”. 

3 Save the new sprite as “Sprite Blue Bird” 
in the “Bird” folder.

Not only movies are great media that bring a lot to a presentation. In this section, we will work with sprites (also called 
flipbook animations) and sounds. You will learn how to create a sprite, move a sprite along a drawn path, link objects 
and share behaviors, add sounds and finally move objects in a screen while running your project.

.

4  The sprite import dialog box will appear. Click on the “+” 
button to add the components of your sprite.

5  Select the “Bird” folder and click on the “Add all displayed 
files...” button to bring all the images in the folder. Another 
way to bring these components is to drag the image file 
from the desktop into the sprite parameter dialog box.

6 In the sprite parameter dialog box, double-click in the 
preview window to get a real-time preview of the “Blue Bird” 
sprite.



1  Go to the Media palette and drag the “Blue 
Bird” sprite onto the “Sprites” screen.

2  In the Command palette, select and drag the  
“Path motion” command onto the sprite.

3  Double-click the Path motion command in the 
sprite.The parameters dialog box will show up.

4  Click on the “EditPath” box .  This 
option turns the Tool palette into a 
path editing tool palette. You can 
create a path using the pen, starting 
from the black dot.

5 Run your presentation from this 
screen.

  - G
Click on the sprite to start it and see 
the Blue Bird flying along the path 
you just drew. Hit the Escape key to 
get back to the Edit mode.

6  The bird is moving along the path but is not 
actually flying. To get it started, go to the 
Command palette, select and drag the Start 
Object command onto the sprite.

7 Double-click the Start Object command  in 
the sprite. The parameters dialog box will 
show up. In the speed area, type 5 to give it a 
speed of 5/60 sec. Click the “Loop” box on.  
This option allows the sprite to play over and 
over.

8  Run your presentation from this screen.

  - G
Click on the sprite to start it and hit the 
Escape key to get back to the Edit mode.



1  Drag “Sprite 
Bird_DBlue” and “Sprite 
Bird_Yellow” from the  
Media palette onto the 
screen window.

2  In the Tool palette, 
select the “Linking” Tool.

3  In one motion, click on 
“Sprite Bird_DBlue” and 
draw a direct line towards  
the object it is taking its 
behavior from : “Sprite 
Blue Bird”. Follow the 
same procedure for  
“Sprite Bird_Yellow”.

4 Run your project from 
the screen. All birds 
should have the same 
behavior. Hit the Escape 
key to get back to the 
Edit mode.

Linking objects avoids duplicating commands for objects having the same functions.

1 Deleting Links
To delete a link, in  the 
Tool palette, select the 
Linking Tool. Then, in one 
motion, click on the 
object you want to free 
from a link and draw a 
direct line towards the 
Katabounga assistant, 
used as a trash.

2 Deleting Objects
Select and drag the object 
to be deleted from the 
screen window onto the 
Katabounga assistant.

3 Deleting Commands 
Select and drag the  
command to be deleted 
from the object in the 
screen window onto the 
Katabounga assistant.

Since you may try new commands,  add media and screens, you will need to know how to delete them in case they are 
not needed anymore.

Deleting Links

Deleting Objects



1  Delete all three sprites and turn the 
background color to black.

2  Go to the Media palette and drag the 
“Gramophone” onto the “Sprites” 
screen.

3  In the Command palette, select and 
drag the “Run Audio Sequence” 
command onto the “Gramophone”.

4 Double-click the Run Audio 
Sequence command in the object. 
The parameters dialog box will show 
up.

5  Hold the mouse down on the  button  
next to the Audio Media box. Select 
music.

6 Run your project from the screen.  
Click on the “Gramophone” object. 
Music should start. Hit the Escape key 
to get back to the Edit mode.

1  Go to the Media palette 
and drag the “Dancer” 
sprite onto the “Sprites” 
screen.

2  In the Object palette, 
hold the mouse down on 
the color selection button 
and move  the color 
picker onto the object to 
select the color you want 
to hide.

3  In the Object palette, 
click on the “Transparent” 
checkbox to hide the 
selected color.

When an object is defined as transparent, it is not the whole object that is transparent, only the selected color is defined 
as transparent.



1  In the Media palette select and drag 
the “Spots” sprite onto the “Sprites” 
screen.

2  Go to the Object menu  and select 
“Send to back”.

When many objects are used in a single screen, being able to organize them is critical. You can work with layers but 
more simply bring object to the front of the screen or send them to the back.

1  In the Command 
palette, select and 
drag the “Send a 
message” 
command onto the  
“Gramophone” 
object.

2  Double-click on 
the Send a 
message  
command in the 
Gramophone 
object. The 
parameters dialog 
box will show up.

We have seen that messages sent by movies can be used to synchronize events. They can also be used to launch new 
events from actions or choices made by the reader. In this example, clicking on the Gramophone object will start both the 
spotlight and dancer sprites.

3  In the Message field, type “Dance Please”. You can 
actually type any message that you find relevant.



4 We will now start both the 
“Dancer” and “Spots” sprites. First, 
in the Command palette, select  
and drag the Start Object 
command onto the “Dancer” sprite.

5  Double-click on the Start Object  
command. The parameters dialog 
box will show up. Hold the mouse 
button down over the “Mouse Up” 
icon. A pop-up menu will appear. 
Select Message.

6  Another field will appear. Hold 
the mouse button down over the 
icon on the right of this field. A 
pop-up menu will appear. Select 
Dance Please.

1  Hold the Option key down. Select and 
drag the Start Object command onto the  
“Spots” sprite.

2  You are done. You have just copied 
the Start Object command with identical 
parameters.

3 Run your project from the screen. Click 
on the “Gramophone” object. Music and 
sprites should start. Hit the Escape key to 
get back to the Edit mode

When many objects are meant to behave the same way, being able to copy the commands attached to an object 
becomes a real productivity tool.

7  In the speed area, type 4 to give it a speed of 4/60 
sec. Click the “Back and Forth” box on. This option 
allows the sprite to play back and forth.



You also have the capability to move an object with the mouse in 
the Play mode using the “Mouse motion ” command.

1 In the Command palette, select and drag 
the Mouse motion command onto the  
“Dancer” sprite.

2  Duplicate the sprite four times by 
selecting Command-D. 

-D

3 Double-click on the Mouse motion  
command. The parameters dialog box will 
show up.

4 Hold the mouse button down over the 
“Mouse Up” icon. A pop-up menu will 
appear. Select “Mouse Down”.

5  Duplicate 4 times this dancer. 

6 Run your project from the screen. 

  - G

You are now able to move these dancers  
while playing  your project.

7  Hit the Escape key to get back to the Edit 
mode.



1 Double-click on the “VR” 
screen icon in the Scenario 
window to make it your 
working screen.

2  Go to the Media palette and 
drag the “VR Floorplan” image  
onto the “VR” screen. 

3 In the Media palette, select  
and drag the “VR.mov” 
QuickTime movie onto the  
screen.

In this section, we will work with QuickTime VR Movies. We will place a QuickTime VR movie on a screen, then we will 
set up commands to navigate through the movie. No scripting skills required.

4 Pull down the Object menu and adjust size to 50 percent.

5 Run your presentation from this screen.

  - G
Click on the VR to navigate through the movie and hit the 
Escape key to get back to the Edit mode.

1 Go to the Media 
palette and drag the 
“Compass” image onto 
the screen. In the 
Object palette, click on 
theTransparent 
checkbox to hide the 
white background.

2  Create two  
rectangular objects on 
the top of the Compass. 
They will be areas to 
click on to navigate 
within each node of the 
VR Movie.

3 In the Object palette, 
click the transparent 
check box on to turn 
them also transparent.



1 Go to the Scenario 
window and click on the 
arrow next to the “VR” 
screen to show the 
objects displayed on this 
screen.

2  In the Command 
palette, select and drag 
the “QuickTime VR 
Control” command onto  
one of  the newly created 
objects on the compass    
-you can recognize them  
as they do not have a 
relevant name yet-. 
Repeat the same 
procedure for the second 
rectangle. 

As we have seen, commands can be applied to objects on the screen. Nevertheless, if objects are very small, such as 
these two rectangles we have just created, it is possible to apply commands to objects in the Scenario window.

3  In the Scenario palette, double-click on 
QuickTime VR Control icon you just applied. The 
VR parameters dialog box will show up.

4 To select the QuickTime VR you will be managing, 
you can either select the VR movie on the screen 
and drag it onto the “Object Name” field, or hold the 
mouse button down over the icon on the right of this 
field. A pop-up menu will appear. Select “VR.mov”.

5  In the Run Conditions area, hold the mouse button 
down over the Mouse Up icon. A pop-up menu will 
appear. Select Mouse Down.

6  In the VR parameters dialog box, click the “Angle” 
check box on as you will manage the horizontal  
angle changes.

7 In the “Angle” area, type  2  to have the angle changing  two 
degrees by two degrees. Click the “Relative Values” check box 
on to have the angle change relative to the previous angle and 
have your VR movie turning around.

8 Use the procedure we just described to have the second 
object making the QuickTime movie rotate with a -2 degree 
angle.

9  Run your presentation from this screen.
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Click on the  transparent objects on the compass to make the 
QuickTime VR Movie rotate two degrees by two degrees. You 
are managing a VR Movie without having to deal with any type 
of scripting.



5  In the Run Conditions area, hold the mouse 
button down over the Mouse Up icon. A pop-up 
menu will appear. Select Mouse Down.

6  In the VR parameters dialog box, click the Zoom 
check box on as you will manage the zooming 
changes.

7 In the Zoom area, type  2  to Zoom in with the 
“Magnify +” button and -2 to zoom out with the 
“Magnify -” button.
Click the Relative Values check box on to have 
the angle change relative to the previous zoom 
position and being able to zoom smoothly.

Zone Zone 2

Using the same procedure, you will be able to 
zoom in and out of a QuickTime VR Movie.

8 Run your presentation from this screen.
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Click on the magnifying lenses to zoom in and out of your QuickTime  VR 
Movie.

1 Go to the Media palette and drag the “Button_Magnify +” 
and “Button_Magnify -” buttons onto the screen.

2  In the Command palette, select and drag the QuickTime VR 
Control command onto these buttons.

3 Double-click on QuickTime VR Control icon. The VR  
parameters dialog box will show up.

4 To select the QuickTime VR you will be zooming in and out, 
hold the mouse button down over the icon on the right of this 
field. A pop-up menu will appear. Select “VR.mov”.

Katabounga also allows you to go from node to node.

1 Create two rectangular objects on the top of the floor 
plan. They will be areas to click on to  go from one node 
to the other one.

2 In the Object palette, click the transparent check box 
on to turn them transparent.
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3  In the Command palette, 
select  and drag the  
QuickTime VR Control 
command onto one of the 
newly created rectangles on 
the floor plan. Repeat the 
same procedure for the 
second rectangle. 

4  Set up the VR parameters 
as shown in the dialog box 
below.

5  Run your presentation from 
this screen.

  - G

Click on the floor plan to 
switch from one point of view 
to another one.


